
For additional written instructional guides, visit us @ http://www.calstatela.edu/handouts  

Adobe Dreamweaver 8  
Part 1: Introduction to Interface and Site Management 

INFORMATION TECHNOLOGY SERVICES 
California State University, Los Angeles 

Version 1.2 Spring 2009 

 
Contents 

Introduction ................................................................................................................................... 2 

Launching Dreamweaver 8 .......................................................................................................... 2 

Dreamweaver Interface ................................................................................................................ 2 
Windows and Panels ................................................................................................................. 3 
Toolbars .................................................................................................................................... 4 

The Insert Toolbar ............................................................................................................... 4 
The Document Toolbar ....................................................................................................... 5 

Panels ........................................................................................................................................ 5 
The Property Inspector .............................................................................................................. 6 

Site Definition ................................................................................................................................ 6 
Creating a Dreamweaver Site ................................................................................................... 6 
Managing Web Pages with a Site ............................................................................................. 7 

Create an Empty Web Page ................................................................................................ 7 
Rename a Web Page ........................................................................................................... 8 
Delete a Web Page .............................................................................................................. 8 

Working with a Web Page ........................................................................................................... 8 
Editing a Web Page ................................................................................................................... 8 
Formatting Text Content ........................................................................................................... 9 
Creating and applying a custom font list ................................................................................ 10 
Changing the Font Size ........................................................................................................... 11 
Creating and Formatting a List ............................................................................................... 11 
Page Property .......................................................................................................................... 12 

Managing Site Definition ............................................................................................................ 13 
Export Site Definition ............................................................................................................. 13 
Remove Site Definition........................................................................................................... 14 
Import Site Definition ............................................................................................................. 14 

Getting Help ................................................................................................................................ 14 

Useful Shortcuts .......................................................................................................................... 15 



 

Introduction 
Adobe Dreamweaver® is the widely used industry standard program for Web site creation. Using 
a design view to create the layout, code view to create scripting and backend, or split screen view 
to work on both simultaneously, users can easily create the page they desire. The added ability to 
integrate other Adobe Creative Suite software such as Photoshop, Illustrator, Fireworks, and 
Flash into the final page design is another benefit of the program. 
 
In this Part 1 handout, users will learn about each tool in Dreamweaver. Users will be guided 
through the interface and its many functions. Included in this handout are steps for organizing 
and creating the structure or foundation for the Web site. 

Launching Dreamweaver 8  
Please note that these directions are based on the settings on the computers in the open access 
labs (OAL) on campus. The steps for launching the program at home or in other computers may 
be slightly different from the ones provided below. 
 
To launch Dreamweaver 8: 

1. Click the Start button  on the taskbar. 

 

2. Select All Programs.  
3. From the All Programs folder list, select Macromedia. 
4. Select Macromedia Dreamweaver 8 from the list of programs.  

Dreamweaver Interface 
When Dreamweaver is launched for the first time, users will be asked to select the workspace set 
up from either Code layout or Designer layout (see Figure 1). For beginner to intermediate users, 
the Designer layout is more appropriate. A different layout can be selected later by using the 
menu Window ► Workspace Layout, and selecting the desired layout. After selecting the 
desired layout, click HTML to create a new file (see Figure 2). 

Figure 1 - Workspace Setup Window 
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Figure 2 - Creating a New File 

Like many applications, Dreamweaver has a Title Bar, Menu Bar, and toolbars. The Document 
Toolbar and Insert Toolbar appear by default, while the others can be added manually. Below 
the toolbars is the Dreamweaver document window in which Web pages are designed and 
programmed. Below the work area is the Property Inspector. If none of these are visible, check 
on Insert and Property in the Menu Bar’s Windows menu. On the far right side of the 
document window is the Panel Group (see Figure 3). 
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Figure 3 -  Dreamweaver Interface 

WINDOWS AND PANELS 
The following briefly describes each element shown in the window and its functions. 
 
 
 



Table 1 - Dreamweaver Interface Features 

Feature Description
Title Bar Displays the name of the application, which is Adobe 

Dreamweaver 8, and name of the file currently shown. 
Menu Bar Contains all the commands available within Dreamweaver 8. 
Insert Toolbar Contains buttons for inserting various types of "objects," 

such as images, tables, and layers, into a document. 
Document Toolbar Contains buttons that provide options for different views 

of the Document window (such as Design view and Code view), 
various viewing options, and some common operations such as 
previewing in a browser. 

Panel Groups Sets of related panels grouped together into tabs under one 
heading. To expand a panel group, click the expander arrow 
at the left of the group’s name; to undock a panel group, 
drag the gripper at the left edge of the group’s title bar.

Tag Selector  Shows the hierarchy of tags surrounding the current 
selection. Click any tag in the hierarchy to select that 
tag and all its contents. Using this feature requires a 
basic knowledge of HTML. 

Document Window Displays the current document and allows editing of the 
page content. 

Property 
Inspector 

Being used to view and change a variety of properties for 
the selected object or text. Each object has different 
properties. 

Files panel Enables management of files and folders, whether they are 
part of a Dreamweaver site or on a remote server. 

TOOLBARS  
Unlike many other applications, Dreamweaver 8 has only a few toolbars, containing mostly basic 
features. Most of the advanced features are contained within the panels.  

To display the standard toolbar: 
1. Select the View menu and move the mouse over Toolbar. 
2. From the submenu, check to display the Standard Toolbar. 

The Insert Toolbar  
This toolbar provides a quick way of inserting different types of objects onto a Web page. There 
are several categories of objects that can be inserted. The table below contains only a short list of 
the the buttons under the Common category that do not require knowledge of HTML.  

Table 2 - Insert Bar, Common Objects 
Icon Feature Description

 
Hyperlink This button allows insertion of a hyperlink.  

 
E-mail link Inserts an e-mail link.  

 
Named Anchor Inserts a named anchor. Hyperlinks can be set to 

jump to named anchors.  

 
Insert Table Inserts a table onto the page.  

 
Images Drop-
down menu 

Click on the drop-down list to show the image tool 
buttons, some of them are listed below. 

 
Insert Image Inserts an image onto the page. 
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Icon Feature Description

 
Image 
Placeholder 

Inserts an image placeholder. The image can be 
placed in the placeholder later. 

 
Rollover 
Image 

Allows insertion of a rollover image. Two images are 
required for this feature. 

 
Navigation 
Bar 

Inserts an image navigation bar on the page.  

 
Media  Click on the drop-down list to show the media tool 

buttons, some of them are listed below. 

 
Flash Inserts an existing Adobe Flash object into the 

page. 

 
Flash Button Allows users to create a Flash button as a hyperlink 

into the page. 

 
Flash Text Allows users to create a Flash text object. 

 
Date Inserts today’s date onto the page. The date can be 

updated automatically each time the page is edited. 

 
Comment Inserts comments onto the page. Comments are hidden 

once the page is displayed using a Web browser. 

The Document Toolbar 
The page being worked on can be viewed in several different ways in Dreamweaver. The buttons 
on the Document Toolbar can be used to easily switch the view, simplifying the editing and 
organizing process.  

Table 3 - Document Toolbar Buttons 
Icon Feature Description

 
Code View HTML code editing view of the Web page. 

 
Code and 
Design View 

A split screen with HTML code on the top and its 
WYSIWYG (What You See Is What You Get) equivalent 
of the Web page at the bottom. 

 
Design View Displays the Web page in WYSIWYG editing mode. 

 
Page Title In this text box, the Page Title is specified. 

 
Preview/Debug 
in Browser 

Choose a Web browser from the drop-down list to 
preview the Web page. 

 
Refresh This button refreshes the content of the Design 

view. 

 
View Option Display and hide several features of the Document 

Window in Design View such as rulers, grids, and 
guides.  

PANELS 
Panels are extremely useful because they contain most of the advanced features in Dreamweaver. 
Panels are usually located at either to the right or at the bottom of the application screen. 
However, sometimes several panels are grouped into a single panel, and they are displayed as a 
tab. Each panel has a specific purpose, and must be brought to view before using. 

To display or hide a panel: 
1. Select the Window menu. 
2. Check to display or uncheck to hide any panel(s) on the menu. 
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THE PROPERTY INSPECTOR 
The Property Inspector is context-sensitive, meaning it constantly changes depending on what 
type of element is selected.  This panel controls many settings, including those for text, tables, 
alignment, and images. The Property Inspector will be used extensively thoughout the handout.  

Site Definition 
Dreamweaver provides an easy way of organizing all of the documents associated with a Web 
site, which is by creating a site. A site is required to take advantage of many Dreamweaver 
features, (i.e., managing files, automatically tracking and updating hyperlinks, and uploading the 
site to the Internet). Organizing the files in the site can also simplify the process of creating Web 
pages. Within a site, inserting images and hyperlinks can be done by just drag and drop.  

CREATING A DREAMWEAVER SITE 
Dreamweaver provides a Site Definition Wizard that can be used to create a Site.  

To create a site: 
1. From the Site menu, select New Site…, the Site Definition Wizard Starts. 
2. In the What would you like to name your site? text box, type “Personal”. Click on Next 

(see Figure 4). 

 
Figure 4 - Site Definition 

3. Select the No, I do not want to use a server technology option button ►Next. 
4. Make sure the option button Edit local copies on my machine, then upload to server 

when ready is selected. ► Click on the  button and browse for the folder in which to 
store all the files in the site (create a folder on the desktop). ► Click Open ► Click 
Select ► Click Next.  

5. Under How do you connect to your remote server? drop down list, select the None 
option from the list. ► Click Next. 
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6. Review all of the information about the newly created site. ► Click Done if everything is 
correct. A site has been created, now the Files Panel should look as follows (see Figure 
5). 

 
Figure 5 - Files Panel After Site Definition 

MANAGING WEB PAGES WITH A SITE 
After the Site is created, Dreamweaver can be used to create, rename, or delete Web pages in the 
site. The Files Panel is used to manage all the files within Dreamweaver. This is not only an easy 
tool to use, but there are also several benefits inherited into using this Panel.  

Create an Empty Web Page 
Using this method, an empty page is created directly within the site. This is a quick way to create 
one or several Web pages. Pages created can be opened and edited later on by double-clicking 
this file name. 

To create an empty Web page: 
1. Right-click in the Files Panel, located at the right corner of the Application Window. A 

context menu will appear (see Figure 6). 
2. Select New File from the menu. A new Web page named “untitled.html” is created. 
3. Rename the Web page, “index.html”. 

 
NOTE:  It is recommended that “index.html” or “index.htm” be used as the home page of a Web 
site, because “index” is the default page that most browsers search for. For example, when 
visiting CSULA Web site by typing [http://www.calstatela.edu], the actual Web page viewed 
is “http://www.calstatela.edu/index.html”. 

4. Repeate steps 1 and 2 to create two more pages, “pics.html” and “hobbies.html”. 
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Figure 6 - Create New File 

Rename a Web Page 
When a Web page is renamed, Dreamweaver will search for files that has hyperlinks pointing to 
the old file name and ask whether to update the links to point to the new name.  

To rename a file: 
1. Select the file to rename in the Files Panel. 
2. Press [F2] on the keyboard to hightlight the file name. 
3. Type the new name and press [Enter].  

Delete a Web Page 
Before deleting a Web page, Dreamweaver will check whether there are files within the site that 
have links pointing to the file and display an alert. If there are any, those links can be located and 
modified to avoid the “Dead Link” problem. 

NOTE: A Dead Link, also known as a Broken Link, is a situation where the link destination does not 
exist. This problem may occur because the destination URL is mistyped or the html file of the destination 
link no longer exists.  

To delete a Web page: 
1. Select the files to delete in the Files Panel. 
2. Press [Delete] on the keyboard.  
3. Click the Yes button to confirm deletion.  

Working with a Web Page 

EDITING A WEB PAGE 
Editing a Web page in Design View is as easy as typing text into a text editor. Although 
Dreamweaver’s Design View is a WYSIWYG (What You See Is What You Get) environment, 
after editing the page always use an actual Web browser, i.e., Internet Explorer, Netscape, to 
view the page.  
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To edit the home page:  
1. Double-clicking “index.html” in the Files Panel.  
2. Type “Welcome to My Web site” at the top of the page and press [Enter].  
3. Type an introduction paragraph and press [Enter].  
4. Below the introduction paragraph, type a list: “Basics of the program” then press [Enter].  
5. Repeat for “Creating Web pages”, “Adding Images”, “Creating Links”, “Advanced 

features” and “etc...”. 
6. Type the footer message; “by ITS Training Program”.  

NOTE: A bad introduction may drive people away from browsing the site, so the introduction has 
to be well written and reviewed. An introduction paragraph can describe the content of this Web 
site, the goal the site is trying to achieve, and/or what people can expect to find within the site.  

 
Even a very simple footer is important to a Web page. Without footer, visitors would not 
have a clear indication as to whether a Web page has completely loaded or not. 

FORMATTING TEXT CONTENT  
The Property Inspector offers options on manipulating text through such features as fonts, 
alignment, coloring, and predefined formattings.  

To format the page title using predefined formatting: 
1. Select “Welcome to My Home Page” text. 
2. From the Format dropdown list, select “Heading 1” (see Figure 7). 

 

 

Select “Heading 
1” from the 
list 

Figure 7 – Use Predefined Formatting 

To format the introduction paragraph: 
1. Select the introduction paragraph. 
2. Click on the Font dropdown list and select Arial, Helvetica, sans-serif (see Figure 8).  

 
NOTE: This will apply the “Arial” font face to the text, and with any computer in which the 
“Arial” font is not available, “Helvetica” will be used instead, and so on. 

 

 
Figure 8 - Change Fonts 
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CREATING AND APPLYING A CUSTOM FONT LIST 
The Font list contains a list of the most commonly used fonts in Web pages and are almost 
guaranteed to be available in any computer. However, users are restricted to only use fonts on 
that list. Dreamweaver allows users to define their own font lists and add them to the main Font 
list.  

NOTE: If a Web page is formatted by using these fonts, and the visitor’s computer do not have those 
fonts installed, then the Web page would be displayed only in some basic fonts, usually Arial or 
Times News Roman. 

To define a custom font list: 
1. Click on the Font dropdown list and select Edit Font List…, the Edit Font List dialog box 

appears (see Figure 9). 
2. From the Available fonts: list, select “Tahoma” ► Click on  to include it to the 

Chosen fonts: list. This is the font that will be applied to the text.  
3. Select “Microsoft Sans Serif” and include that in the Chosen fonts: list. It is a good 

practice to always include another font in case the first font selected can not be viewed by 
a visitor.  

4. The Font list: list can be reordered by using the  and  buttons. 
5. To add more custom lists, click on the  button. To delete a list, click on the  button. 
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Figure 9 - Edit Font List Dialog Box 

To apply the custom list: 
1. Select the footer text. 
2. Click on the Font dropdown list and select Tahoma, Microsoft Sans Serif.  

Use +/- to 
add/delete 
lists Use the arrows 

to reorder the 
font list 

Select font from 
Available fonts 
list and click to 
add into the list



CHANGING THE FONT SIZE  
There are two ways of specifying font sizes: absolute and 
relative.  

In Dreamweaver 8, both ways are combined into the Size: 
dropdown list. Absolute sizes can be set by selecting the 
specific font size number, while relative sizes are the 
textual description below. 

NOTE
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: It is recommended to specify relative font size, 
because it changes according to different screen resolution. 
However, absolute font size is fixed no matter which 
resolution is used. 

To change the font size: 
1. Select the footer text. 
2. Click on the Size dropdown list and select “small” 

(see Figure 10). 
 

Figure 10 - Font Size Dropdown List 

Absolute 
font size 

Relative 
font size 

CREATING AND FORMATTING A LIST 
The two most common types of lists used on Web pages are unordered lists and ordered lists. 
Menu lists and directory lists are used, but much less frequently. Each item in an unordered list 
has either a square or a round bullet in front of them, and items in an ordered list is preceded by a 
sequence of numbers, roman numeral, or letters. 

To create an unordered list using the Property Inspector: 
1. Select the list of topics on the page. 
2. Click on the Unordered List button . By default, a round bullet is used in front of 

each list item. 

To change into an ordered list using roman numerals:  
1. Select or click on one item in the list.  

NOTE: Selecting the entire list will not activate the List Item… button. 
 

2. Click on the List Item… button  on the Property Inspector. The List 
Properties dialog box will appear (see Figure 11). 

3. Click on the List type: dropdown list and select Numbered List. 
4. Click on the Style: Dropdown list and select Roman Small (i, ii, iii…). 
5. Click OK. 
 



 
Figure 11 - List Properties Dialog Box 

PAGE PROPERTY 
The Page Property feature controls many important attributes of the Web page, including the 
document title, colors set for text and links, and background color or image. 
To open the Page Properties dialog box (see Figure 12), go to Modify menu  and select the Page 
Properties command or simply press [Ctrl + j]. See Table 4 for a description of commonly used 
features in this dialog box. 
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Figure 12- Page Property Dialog Box 

Table 4 – Commonly used Functions 
Property Description
Title The title of the page is what will appear in 

the title bar of the Web browser and when 
the page is bookmarked.  This name can 
contain as many characters as necessary, 
including special characters. 

Background Image An image could be optionally used as a 
background for the Web page. A background 
image can be any .GIF or .JPG file. If the 
image is smaller than the Web browser 
viewing area, it will repeat (tile). 

Background Sets the background color. The values can be 
in hexadecimal format or in color name. 

Text Sets the default text color. It can be 
overwritten for specific areas of the text. 

Links Sets the color for links. This option can be 
overwritten for specific links. 

Select 
different 
categories to 
show fetures 
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Property Description
 

Visited Links A visited link color specifies how the link 
will appear after a visitor has clicked it. 

Active Links The active link color specifies how the link 
will appear while someone clicks it. 

Document 
Encoding 

Specifies the language for the characters 
and fonts used in the document. 

Tracing Image Tracing images are used as guides to set up 
the layout of the page.  They can be any 
.GIF, .JPG, or .PNG file. 

Transparency Sets the transparency level of the tracing 
image. 

Left Margin Sets the left margin value in pixels. 
Top Margin Sets the top margin value in pixels. 
Margin Width Sets the margin width value in pixels.  
Margin Height Sets the margin height value in pixels.  

Managing Site Definition 
Once a Dreamweaver site is created, site information is only stored within the computer used to 
create the site. This could be a problem if the user transfers the files to a different machine, then 
the site must be defined again. Fortunately, Dreamweaver allows exporting of all the site 
information. Later on, this information can be imported back into Dreamweaver to re-create the 
site. 

EXPORT SITE DEFINITION 
All the site definition, such as site name, location, etc… , will be exported to a definition file 
with extension “.ste”. During exporting, only site definition is exported, none of the files in the 
Web are included in the export process. Therefore, to create a copy of the site in a different 
machine, both  the “.ste” extensioned definition file and the folder containing the Web pages 
must be copied.  

To export site definition: 
1. From Site menu, select Manage Sites… The Manage Sites dialog box opens (see Figure 

13). 
2. Select the site, and click the Export… button, the Export Site dialog box opens.  
3. Click on the Desktop button to save the site information on the Desktop. 
4. Click on the Save button. The site information has been saved into personal.ste file on the 

Desktop.  
5. Click Done to close the dialog box. Site information will be saved on the desktop in the 

file “personal.ste”.  

NOTE: The root folder needs to be saved together with the “.ste” extensioned definition file in 
the same storage device. This way can prevent data missing when importing the site. 



 
Figure 13 - Manage Sites Dialog Box 

REMOVE SITE DEFINITION 
Removing a site in Dreamweaver will only delete the site definition, none of the actual Web 
pages, images, or other files within the site are affected. Therefore, to completely delete a site, 
first remove the site definition within Dreamweaver, then manually locate the folder containing 
the Web pages and delete it. 

To remove a site definition: 
1. From the Site menu, select Manage Sites… The Manage Sites dialog box opens. 
2. Select the personal site, and click on Remove button. 
3. Click on Yes (site information deleted can not be recovered). 
4. Click on Done to close the dialog box. 

IMPORT SITE DEFINITION 
A site can be re-created by importing its site definition into Dreamweaver.   

1. From the Site menu, select Manage Sites… The Manage Sites dialog box opens. 
2. Click on the Import button. 
3. To locate the Dreamweaver Site information file, click on the Desktop Button and select 

the file “personal.ste”. 
4. Locate the folder containing all the Web pages and click on Select. Now the site 

“Personal” should be added in the site list. 

NOTE: This step is skipped if the folder is the same as the original path exported.  
 

5. Click on Done to start the import process.  

Getting Help 
Dreamweaver 8 has Help menu to provide useful information for users. In the Dreamweaver 8 
Help window, users can use Contents, Index, and Search tabs to look for best answers for 
particular questions. 

To  open the Dreamweaver 8 Help dialog box: 
From  the Help menu, select Dreamweaver Help. The Dreamweaver 8 Help dialog box opens 
(see Figure 14). 
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Figure 14 - Dreamweaver 8 Help Dialog Box 

To use the Dreamweaver 8 Help dialog box:  
1. Click on Content tab, click on one apporiate topic. The information will appear on the 

right side of the window. 
Or 
2. Click on Index tab, enter keywords in Type in the keyword to find:  text box. Click 

Display button. Select one apporiate topic and the information will appear on the right 
side of the window. 

Or 
3. Click on Search tab, enter keywords in Type in the word(s) to search for: text box. Click 

List Topics button. Select one apporiate topic and the information will appear on the 
right side of the window. 

 
Useful Shortcuts 
Dreamweaver 8 is rich with shortcut keys. This table will cover only the most common ones (see 
Table 5). 

Table 5 - Shortcuts in Dreamweaver 8 

Command Description

Ctrl + n New Document. 

Ctrl + s Save Document. 

Ctrl + j Page Property. 

Ctrl + f Find and Replace. 

Shift + Enter Line Break. 

Double Click Select a word. 

Triple Click Select a paragraph. 

Shift + F7 Check Spelling. 

Ctrl + Shift + i Insert Images. 

Ctrl + F2 Object. 

Ctrl + F3 Property Inspector. 

Shift + F3 Behaviors. 

Ctrl + Shift + F6 Switch to Standard View. 
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Command Description

Ctrl + F6 Switch to Layout View. 

F8 Site Panel. 

F10 Color Inspector. 

Shift + F10 History. 

F12 Preview in Primary Browser. 

Ctrl + F12 Preview in Secondary Browser. 
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